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Pro-Zipcode / Pro-Zipcode Deluxe Documentation

Introduction:

Thank you for trying / buying our products! This document will explain the product and file
layout.

Product Info:
BASE PRODUCTS:

Pro-Zipcode: This product lists each 5-digit Zip Code, along with the appropriate city, state and
county information assigned to each Zip. If more than one city or county exists for a Zip Code,
only the Primary City is listed.

Pro-Zipcode Deluxe: This is similar to the Pro-Zipcode product but lists all city and towns
associated with each Zip Code. This also has a sequence number for each city/town within each
Zip (1 is for the primary city/town based on the population of that city within that zip code, 2 is
for the secondary city/town, etc.) This code can be used in an index so that the record with
sequence #1 is the default record for selecting a city in a pop-up list.

In some cases, the county information is more accurate because we can assign the county that
the individual city is in. For instance, let’s assume that 60% of the county for a Zip is DeKalb.
The Pro-Zipcode file will have DeKalb, but the Deluxe may have a secondary city for that Zip
Code and the city could be in another county. Again, this is not on all records because it takes
manually verifying with maps.

This product includes a City Code Designator which indicates whether the USPS considers the
city to be a Primary City (P), an Acceptable City (A), or a Non-Acceptable City (N). We
recommend that you load the Non-Acceptable records because many people still use them as
part of their address. The USPS is not always consistent in how they code places. For instance,
they may say that ‘North Anytown’ is not acceptable, but ‘N Anytown’ is acceptable.

These files contain all valid U.S. Zip Codes which include the continental U.S. states, Alaska,
Hawaii, Guam, U.S. Virgin Islands and other U.S. territories. We also have military APO/FPO
codes which have their own state codes: AE, AA, and AP. The State Department also has DPO
(Diplomatic Post Office) codes within these state codes.

ADD-ON PRODUCTS:

Each add-on product is a separate product which appends to the base product. You may
purchase any or all of these products, according to your needs. Our Extractor program
combines the base product with the add-ons you’ve selected into one file. Therefore you won't
have to match up separate data elements.
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Latitude / Longitude: This is the approximate center of a Zip Code's latitude and longitude. This
is commonly used in finding the nearest dealer / store, etc. For records where we have
researched the coordinates, we assign a population-based center point, rather than a
geographical center. The reason for this is that the physical center could be in a lake, airport,
golf course, forest, etc.

Area Code: This gives you the Primary area code for each Zip Code. Sometimes there may be
an overlay where area code 111 was the original area code and now area code 222 covers the
same area. The original area code will be included, since most people will have that code, not
the new one.

FIPS Codes: This lists the 2-digit state, 3-digit county and 5-digit place (city/town) FIPS (Federal
Information Processing Standard) codes. These codes are not available for all areas such as
APO, FPO records and some U.S. Territories. Some towns don’t have a matching 5-digit
city/town code.

MSA Codes: These are Metropolitan Statistical Area codes. These codes define greater
metropolitan areas such as the greater Miami area. Not all Zip Codes have an MSA code
because many Zips are in rural areas. When you purchase the MSA codes, we also provide a
copy of the file, 'msa-list.txt' which lists the metropolitan area and its corresponding code.

MSAs, CMSAs and PMSAs are defined by the U.S. Office of Management & Budget (OMB). The
definitions are often obscure, but an MSA usually includes one city with 50,000 or more
inhabitants and the county which the city falls within. It can also include nearby counties if they
are within commuting distance.

A CMSA is a Consolidated MSA. It will contain a larger area where the combined population is
one million or more people. If an area falls within the CMSA, then the individual cities comprise
PMSAs (Primary MSAs).

For instance, Abilene, Texas has a population of about 124,000 and is MSA code 0040. Akron,
Ohio is PMSA 0080 because it is part of the Cleveland-Akron CMSA (1692).

We do not use CMSA codes in our data, just the PMSA, because the PMSA is the smaller unit and
more precise. Please refer to the 'cmsa-all.txt' file for a list of all PMSAs in a CMSA.

Time Zones: Currently, we have the U.S. time zones in a standard format which is the number
of hours from Coordinated Universal Time (UTC) which was formerly called Greenwich Mean
Time (GMT). West of UTC is negative and so all U.S. records have negative numbers. The zones
range from -5 (Eastern Standard Time) to -10 (Hawaiian Standard Time).

Type Codes: We have had many requests to add on the U.S. Postal Service's type codes. These
codes can be exported by selecting the option in our Extractor program. The codes are as
follows:

e Blank = General Delivery, which may include PO Boxes.

e b =Business/Government private 5-digit Zip Code.
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e e =PO Box only (no General Deliver)

e m = Military

FILE LAYOUT:

Note: on legacy products using the Extractor program and for fixed-width files, header labels are
not used. For new, delimited products, we have a header record as the first record in the file.

BASE PRODUCTS:

All files are normally comma-delimited ASClII files. If you purchased the Pro-Zipcode Base
Product, the first fields are:

e Zip Code (5 digits long)
e State Abbreviation (2 Characters long)
e City (up to 30 characters)

e County (up to 30 characters)

If you purchased the Pro-Zipcode Deluxe Version, the first fields are:

e Zip Code (5 digits long)

State Abbreviation (2 characters long)
e City (up to 30 characters)
e County (up to 30 characters)

e Sequence Number (up to 2 digits long). This will be a ‘1’ for most records, but could be
a‘2’, ‘3, etc. for Zip Codes that have multiple cities. ‘1’ is for the Primary City for that
Zip Code (based on population counts), ‘2’ is secondary, etc.

e P,AorN. This will be 'P' if the USPS considers this city name the Primary City, it will be
'A' if they consider it an Acceptable city name or 'N' if it considers it Not Acceptable.
Normally, most people ignore this code and will use the city even if it is coded as an 'N".

ADD-ON PRODUCTS:

If you purchased any add-on products, the fields will be listed in the following RELATIVE order,
depending on whether you purchased the add-on or not:

e latitude & Longitude. The format for Latitude is: 99.999999 and the format for
Longitude is: -999.999999. Note that West Longitudes (just about all of the U.S.
locations), contain a negative number. The only exceptions are some U.S. territories in
the Pacific that are past the date line.

e Area Code (3 digits long).
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FIPS Codes (10 digits). The state is the first 2 digits, the county is the next 3 digits and
the city/town is the remaining 5 digits.

MSA Codes (4 digits long).

Time Zones (Format: -99). Note that most U.S. Time Zones are negative, just like
longitudes. Eastern Standard Time is -5 and Hawaiian Standard Time is -10.

Daylight Savings Time flag (part of the Time Zone add-on). It will be 'Y'if the area
observes Daylight Savings Time and 'N' if it doesn't.

FIXED FILE FORMATS:

If you have received this data in a fixed format, the record layout will contain no commas or
filler and the field lengths will be the maximum length indicated. The order that the fields
appear will be in the same relative order mentioned above. For instance:

01-05 ZIP Code

06-07 State Abbreviation
08-37 City Name

38-67 County Name

Optional Fields:

The Sequence Number (for Pro-Zipcode Deluxe only) (2-digits)
Acceptable/Not-Acceptable field (for Pro-Zipcode Deluxe only) (1 character)
Latitude (Format: 99.999999)

Longitude (Format: -999.999999)

Area Code (Format: 999)

FIPS Codes (Format: 9999999999) (the state is the first 2 digits, the county is the next 3
digits and the city/town is the remaining 5 digits)

MSA Codes (Format: 9999)
Time Zones (Format: -99)

Daylight Savings flag (1 Character)

DATA FILE NAMES:

Our data files have the following naming structure:

PREFIX:

If it is a Pro-Zipcode product, it will begin with 'PZ' (not 'PZD").

If it is a Pro-Zipcode Deluxe product, it will begin with 'PZD".
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ADD-ONs:
e |If Latitude/Longitude is included, the next character will be an 'L".
e |f Area Codes are included, the next character will be an 'A'.
e |f FIPS Codes are included, the next character will be an 'F'.
e |f MSA Codes are included, the next character will be a 'M".
e |f Time Zones are included, the next character will be a 'T".
SUFFIX:

Legacy system file names: the suffix will be either '.DEM' for DEMO files or ".FUL' for the FULL
Version. If this is a fixed-length file, the suffix will be either '.FXD' or '.FXF'. Note: you can
change the suffix to ‘txt’ or another suffix when exporting.

New naming system: we are using a new naming system for custom files and new products.
The suffix will consist of multiple parts:

e  First, it will have ‘~full’ or ‘-demo’.
e Ifthe fileis in a fixed-width format, it will have ‘-fixed’ appended.

e The file will end in “.txt’ for either comma-delimited or fixed-width files.

ADDITIONAL FILES:
e pro-zip.txt: This is an older version of this help file in a plain-text format.
e pro-zip.htm: This is an older version of this help file in a web-page format.
e lat-long.txt: This introduces you to our products with latitude/longitude.

e lat-long.htm: This gives you sample code to calculate the distance between two sets of
latitude/longitude coordinates. This is only included in the latitude/longitude products.

e msa-list.txt: This is the master list of MSA codes. It contains the code along with the
name of the metropolitan area. Itis included with any file that has MSA codes in it.

e cmsa-all.txt: This is a master list of all PMSAs within a CMSA. The first field is the CMSA
and the second is a PMSA within that CMSA.

e states.txt: This is a list of U.S. and Canadian state and province abbreviations and names
along with the country abbreviation. This includes all U.S. territories (Guam, U.S. Virgin
Islands, Puerto Rico, etc).

e pzewin.exe: This is the DOS-based extraction program to extract data files.

MICROSOFT ACCESS IMPORTING INSTRUCTIONS:

e We recommend that you first rename the file suffix from '.dem' or ".ful' to ".txt', such as
'pz.txt'.

e The file type is a Text File.
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e The fields are delimited with a comma.
Use the following Data Types:
e The Zip field should be a Long Integer.
e The City, State, County and Acceptable/Not-Acceptable fields are Text.
e The Sequence field (in the Deluxe version) is Integer.
e The Area Code is Integer.
e The Latitude and Longitude fields are Double.
e The State, County, and City FIPS Codes are Integers.
e The MSA codes are integers.

e The Time Zones are integers.

Let Access create the primary index based on the record I.D. Also index Zip Code and any other
fields you want.

Important Note: Change the format of the Zip column if you want the leading zeroes to show up
(some states have Zips less than 10000.) In older versions of Access you can do this by opening
the database and then going to the 'View' menu and choose 'Table Design'. Next select the Zip
Code field and put five zeroes (00000) for the format of the Zip Code field.

Access 2003:

Choose the following options: View, Database Objects, and Tables. Highlight the database and
select the Design icon. This will bring up your table design. Select the Zip Code field in the top
section. Next, and in the Field Properties section, change the FORMAT to be five zeroes (00000).

Access 2007:

From the Design tab, click on the View down-arrow and choose Design View. The Zip Code field
should be the first field and already selected. Below will be the Field Properties section and the
General tab should be selected. The Format field should have five zeroes (00000).

MICROSOFT EXCEL IMPORTING INSTRUCTIONS:

e We recommend that you first rename the file suffix from '.dem' or ".ful' to ".txt', such as
'pz.txt'.

e Gointo Excel and choose to open a file. Change the 'Files of Type' option to 'Text Files'.
e Enter the folder and file name in the File Name section, such as: \Pro-Zip\pz.txt

e It should now bring up the first screen of the Text Import Wizard. Make sure the
options for Delimited and Start Import at row 1 are selected.
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o Select Next to get to the next screen. Comma should be the delimiter and the Text
Qualifier should be '{none}'. Click on Next to continue.

e The Zip Code and any numeric columns should be General. The city, state and county
info should be Text. Highlight the gray bar above each field and then change the
Column Data Format.

e Click on Finish.

e The spreadsheet should now display. Highlight column A (the Zip Code field). For
versions before the 2007 version of Excel, do the following:

Choose Format, Cells from the menu bar.

There should be a Special option and Zip Code selection. Select Zip Code & click
on OK.

The leading zeroes should now display in the Zip Code field.

For Excel 2007, do the following:

Disclaimer:

From the Home tab, in the Cells section, click on the Format down-arrow.
Choose Format Cells.

There should be a Special option and Zip Code in the Type section. Select Zip
Code & click on OK.

The leading zeroes should now display in the Zip Code field.

We have tried our utmost to ensure the validity of the data in these products, but cannot be
held liable for any losses incurred by users of this product in the event that any info is
inaccurate. If you believe any of our data to be incorrect, please e-mail us and we will
investigate the matter.
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